LN _J N‘I "'l" ._. -\._: :. '.I &
" Q\\\*“"‘&%\\W\*\ SRR
S v, N : *
— BUILD AND PROGRAM ROBOTS THAT DO WHAT YOU WANT!
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WELCOME TO THE WORLD OF
LEGO® MINDSTORMS®

Congratulations on your new LEGD® MINDSTORMS® NXT robotics foal set. You
now have the power to build and program robofs that do what you want!

Dream it, build it

Your MINOSTORMS NXT set enables you fo create thousands
of robotic inventions. Intelligent robots that see, hear,
speak, Feel and move. Advanced robofs that you can control
with your mohile phone. Cool robats that guard your room
and do your chores. If you can dream if, you can build if.

Build. Program. Go!

Creating a MINDSTORMS robot is easy. Build the robot using
your LEGO elements. Program it using the easy-fo-use soft-
ware and watch your robot come alive, For your first robofic
adventure, try out the quick-build model that you can build
and program in less than 30 minutes.

Smart technologies

Your MINDSTORMS NXT set features the latest in robofic technology: an
advanced 32-hit programmable microcontroller; icon-based drag and drop
programming software and interactive challenges; smarf sensors and Inter-
active Servo Motars; wireless Bluetooth and USB connection. In fact all the

smart fechnologies you need to create your dream robot.

MINDSTORMS.com

You are now a part of the worldwide LEGO MINDSTORMS community. Log on
to MINDSTORMS.com and get more robotic challenges. Download programs,
sound effects and other cool stuff. Share your inventions and exchange tips
and tricks with other MINDSTORMS users. www.MINOSTORMS.com is your new

robotic hot spot.

Find out more

"'y |n this User Guide you can learn more about the fechnology
and the many exciting features in your MINDSTORMS set.

Have fun building your own amazing robots!

The LEGD HINDSTORMS team.
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_J INTRODUCTION

BUILD. PROGRAM. GO!

L
Build
Build a robot. You can find building
instructions in this User Guide, in the
software or at www, MINDOSTORMS.com.
Or you can use your imagination fo
build your own unigue robot,

Program

Program your robot to do what you
want, Use the LEGO® MINDSTORMS® NXT
Software to make a program. Download
the program o the NXT by using the
LSE cable or the wireless Bluetooth
connection,
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Quick Start

|\ Use the Quick Start kit to get your first

MINDSTORMS experience. In the Quick
Start kit you will And everything you
need to get off to a great start, It will
only take you a few minutes fo create
your first MINDSTORMS robot, test it,
and get a fun reaction.

Go!
Run the program and watch your robot
come to life.
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NXT TECHNOLOGY OVERVIEW
The NXT

The NXT is an intelligent, computer-controlled
LEGO® brick and the brain of the MINDSTORMS® robat,

[_‘,-'{l Touch Sensor

Enables the robot to feel and react to
its environment.

Sound Sensor

Enables the robot to hear and react fo
sound.

\‘OO Light Sensor
Enables the robot to detect lightand
calor.
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Interactive Servo Motors

Ensure that the robot moves with precision.

Standard port settings for sensors
and motors
To make your robot work correctly, the sensors and

| motors should be connected fo specific input and out-

put ports. Here are the standard part seftings:

Input ports

Port 1: Touch Sensor
Port 2: Sound Sensor
Port 3: Light Sensor

Port & Ultrasonic Sensor

Output ports

. Port A: Mator used For an exfra function
U”'I"asn['"t 5E|‘|5[]r Port B: Mator for movement

Enables the robot to see, measure Port C: Motor for movement

distance to an ohject, and react to

movement, ; =

s
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CONNECTING THE NXT TECHNOLODGY

et ) Haote that ALL of the black B-wire
cables can be used in bath inpuf
and output porfs, sensors and
motors, To work, sensors MUST be
attached to the input ports [1-4]
and motors MUST be attached fo
the output ports [A-C).

Connecting motors

To connect a motar to the NXT, use one of the black b-wire
tables, Attach one end of the cable to the motor and the other to
one of the NXT's output ports [A, B, or C).

Connecting sensors
To connect a sensor fo the NAT, use one of the black B-wire
cables, Attach one end of the cable to the sensor and the ather

to one of the NXT's input ports [1, 2, 3, or 4).

Downloading and uploading

The U5B port and wireless Bluetooth connection let you download and
upload data between your computer and the NXT. IF your computer has
Bluetooth capability, you can download pragrams to the NXT without using
the USB cable. IF your computer does not have Bluetooth capability, you
must use the USB cable or install a Bluetooth USH dongle on your computer.
NOTE: Read more about wireless Bluetooth communication an page 28.
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i pmmssmmmsm, | Lonnecting the NXT to a PCwith a LU5B cable

! Turn an the NXT.
9 Hake sure that the
LEGO® MINDSTORMS® NXT

Software is installed before
connecting your NXT fo your PC
|see page 18],

Connect the PC and the NXT with the USE cable.

When the PC identifes the NXT it will automatically Analize the
installation of the LEGO MINOSTORMS NXT Software,

i/ Found New Hardware

Your new hardware is installed and ready to uss,

Connecting the NXT to a Macintosh with a USB cable

Make sure that the LEGO MINOSTORMS NXT Software is installed before connecting your NXT fo
your Macintosh [see page 39].

Turn an your NXT.

Connect the USB cable to the NXT.

Connect the USB cable to the Macintosh and you're ready to go.

—_—
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ABOUT THE NXT

The NXT is the brain of a MINOSTORMS® robat. |t's an intelligent,
computer-cantrolled LEGD® brick that lets a MINDSTORMS rabot come
alive and perform different operations.

Please note that all text on the NXT display is in English.

Motors ports
The NXT has three output ports for affzching &

motors. To make the motor wark, the mators
need to be attached to port A, B or C

|
L

Bluetooth icon

The Bluetooth icon shows the current status of

any wireless Bluetooth connections, IF there is no E
Bluetooth icon shown, Bluetooth is OFF.

#

Bluetooth is ON buf your NXT is not visible to
other Bluetooth devices.

<

Bluetanth is ON and your NXT is visible fo efher
Bluetonth devices.

F
Rluetooth is ON and your MXT is connected fo &
Blueteath device.

lﬁ*

USH icon

Wihen yau cannect your NXT to a computer with (L=
a LI58 cable, a USH icon will be displayed. |F you
discannect the USH cable, the icon will disappear,

USE connected and working fine,

0
1158 connected but not working properly.

]

[

I
| O L

-
U5H port
Connect a LISH cahle to the USE part and down-
load programs from your compuker to the KXT for
upload data from the robot to your computer|.
You can alse use the wire|ess Bluetooth connec-
tion For uploading and downloading.
|
= 4

Sensor ports
The HXT has Four input ports for attaching sen-
sors, The sensors need to be atfached to port 1,

2, 3or4,

L
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~——ede Haming the NXT
You can change the name of your NXT by going to
the MXT window in the software. This window is
accessinlo from the Controller. NXT names can be
at most eight characters lang.

Ly T o tatterylevel
The battery icon dicplays the power level of the

NXT. When battery power is low, the battery icon

will lagh on and off, = 1 e W

Technical specifications
» 32-hit ARMT microcanfroller

- & | = Runningican O « 256 Kbytes FLASH, B4 Khytes RAM
When your MXT is furned on, the running icon will o B-bit AVR mi troller
spin, IF the running icon stops spinning, your WXT J legNL L

. has Frozen and you will need fo reset it [see page .= 4Kbytes FLASH, 512 Byte RAM
74, Troubleshoofing,| |« Bluetooth wireless communication [Bluetaoth Class I
V2.0 compliant]
[ Loudspeaker « LISB full speed port |12 Mbit/s)
Make a pragram with real sounds and listen o « 4 input ports, b-wire cable digital platform [One port
them when you run the program. ; includes a IEC 61158 Type 4/EN 50 170 compliant

expansion port for future use]
= 3 putput ports, 6-wire cable digital platform

-8 NXT buttons » 100 x b4 pixel LCO graphical display .
Orange button: On/Enter ) | = Loudspeaker - 8 kHz sound guality. Sound channel with
Light grey arrows: Used for moving [eff and right 8-bit resolution and 2-16 KHz sample rate. |
in the NXT menu.

Dark grey button: Clear/Go back + Power source: b AA batteries

o ———={L Turning off your NXT
Push the dark grey button repeatedly until you
sep the screen on the right,
Push the orange buttan Fo furn aff yaur NXT,
push the dark grey button to go back fo the main Turm off?
MEenu.

=y
=
>
]
&
LB

NXT display options
Your YT has many other cool features, Read
more about them an the following pages.
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INSTALLING BATTERIES IN YOUR NXT

V),

Battery type
+ The NXT requires b AA/LRE batteries to Function properly.

» Alkaline hafteries are recommended.
= Rechargeahle batteries can be used, but the NXT's power
may he reduced, making the motors furn mare slowly.

Low battery power
When battery power is low, this ican will pop up on the
NXT's display screen.

impurfan’r'
Never mix different types of hatteries in the NXT.
» Always remave hatteries prior fo long-term storage.
= Promptly remove depleted batferies from the NXT.
« Only recharge batteries under adult supervision.
= Never attempt to recharge non-rechargeable batteries.
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NXT MAIN MENU
My Files

The My Files submenu will let you see all of the programs you
have made on the NXT or downloaded from your computer.

Softvare Files MxT Files Sound Files
™ r
Software files - programs you WXT Files - programs you have Sound fles
have downloaded from your matle on the NXT
computer

Files will automatically be placed in the appropriate subfolders. When you
download a program including a sound file to your NXT, the program will be
placed under Software files, while the sound data will be placed under Sound
files. You can send files to other NXTs. Read more about this on page 3b.

T E———— r——




_ | NXT TECHNOLOGY

NXT Program

You don’t need a computer to program your robet. Using
the NXT Program submenu, you can make thousands of
different programs without your computer.

Try this simple program and see how easy it is:

Make the robot go back and forth when its Touch Sensor is pressed.
First, the robot will mave forward until the Touch Sensor is pressed,
and then it will move backwards. When its Touch Sensor is pressed
again, the rabot will move forward once again. This will confinue
indefinitely until you stop the program.

Make sure that your sensors and motors are connected to the right
porfs,

Gelect Forward. Use the arrow buttons Select Touch. Select Backward.
to move through the choices and then

press the orange buttan [Enfer] fo

make your selectian.

1

= . -
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1..‘

!

Select Touch again.

Try these programs as well:

5_-|!

_r |

! ,15.-..‘!

—

How select if you want the program to
Loop. This means that the pragram will
run again and again until you switch
off the NXT. For our little test, select
Laop.

Lﬁ_

(

E.,D__

5

1

I

® —-1| 1
=

_.i

Now you can run your program.
Simply select Run!

| 15
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Try Me

The Try Me submenu lefs you fest your sensors and motors
inafun way:

| 16 |

Cannect the sensors and motors to the appropriate porfs on
the NXT. Important: Use the standard setfings for the ports as
explained on page 7.

Select a program.

When you press the orange |Enter| button, you will get some
fun reactions from the sensors and motors.

Explore other Try Me programs to get some more fun sounds, to
display images and to experience different motar reactions.

You can always delete these Try Me Rles again using the
Settings submenu.
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View

The View submenu lets you carry out a guick test of your
sensors and motors, observing real-time data from each

unif;

Connect the sensor or motor you would like to test to
the NXT - the View submenu will help you select the
right port or check standard settings on page 7.

Select View on the NXT's display.

T 4B ""1.
Fi-00

Select the icon of the sensor or mafor
you would like to test. You can only get
readings from ane sensor or mator af

a Fime,

B _-I I p—— |
! |
N e |
A 3
‘ - il ‘ | 3
2 |
| L
‘g
_____ )
Select the port that the sensor or mo- The data from the sensor or motor will

tor is attached fo. appear on the display,

17 |

e ——
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Settings

The Settings submenu lets you adjust the NXT's settings
including its speaker volume or the Sleep mode setting.
This submenu will also let you delete programs that have
been stored in the NXT's memory.

leep mode: You can set the NXT to turn

itself off after 2, 5, 10, 30 or 60 minutes of
inactivity [time when its not in use|. You can also
select the Never setting so that it remains on
indefinitely [until you turn it off]. Please be aware
that the Never setting will drain your batteries more
quickly,

Idjr:‘i .Idibij
[

Change volume: Delete all programs:

Here you can adjust the volume You are able to delete all downloaded pro-

af the NXT's speakers. grams in the 3 sub Folders: Software files,
NXT files, Sound fles, from the Settings
submenu.

| 18 |
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Bluetooth
P |
| |

.

The Bluetooth submenu will let you make a wireless
connection between your NXT and other Bluetooth devices
|like other NXTs, mobile phones, and computers]. You can use
a wireless Bluetooth connection ta send programs to other
NXTs, to download programs from your own computer
withouf using a USB cable, and lots of ather cool things,
such as using your mobile phone to control your robot! Read
more about wireless Bluetooth communications on pages 28,

19

|
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My Filas MAT Program
e
)
Hy Files NXT Frogram
Sound Fil es (SoftwarsFiles NAT Files) Pl .
! 2 } J Port 2: Saund Sensor !Tlg?r%icﬁseﬁeﬁ;;?'
L Part 3: Light Sensar %: Ei_"-i"”"t'j Egl[l‘:g
Sound files Soffware files NXT fles Port 4: Ultrasonic Sensar |3 - | lerasonie
Part B/C: L/ motors  (BIC - LR mators
Back k| [Turn eft| (Turneft 2| [Ematy| [Bagkuerd (Badiovards| _‘mm 5
1 el = gl gl
Turn left Turn left 2 Empty Backward Backward & Forward 5
(Back left 2 [T-ane 2] [ Tore 1'| Back right Back right 2 [Turn right)
| | ] ! L
e e e o] — [o] el
Back left 2 Tone 2 Tone 1 Back right Back right 2 Turn right
Forward Turn rlqhﬁ_i
il @]
Farward Turn right 2
Suund] Lighk | [Duark | Tﬂu:h] [EI_Tﬂ:lt_'fJ
d ol @] (=2l (I
Sound Light Dark Touch Emply
Objet | (Wait 10] (Wait 5| Wiaik ﬂ
o
] R —UZ] £
Object Wait 10 Wait & Wait 2
" General | 55 =l
eneral ICons. ; 5. m .
| |Filename o
OMBIAT Unkikled Loop Stop

Run

Send |

Send

%:

Save

| & Sending Fi|E]

Sending Ale

I

7 X

Delete
o]

Fil exsis‘ts‘
=5

File existe, Overwrite?

Delete

E.ELE??]_@EJ

File name: Untitled

Main menu

File saved

29 |
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Port 12,3, 4,0, 8,C
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79 TOUCH SENSOR

The Touch Sensor gives your robof a sense of fouch.
The Touch Sensor detects when it is being pressed by
something and when it is released again.

Pressed Released Eumped

Suggestions for use

You can use the Touch Sensor to make your robot pick up
things: a robotic arm equipped with a Touch Sensor lets the
robot know whether or not there is something in its arm to
grab. Or you can use a Touch Sensaor to make your robot act on
a command. For example, by pressing the Touch Sensor you can
make your rabot walk, talk, close a door, ar furn on your TV,

Try Me Testif!

Test the Touch Sensor and get a fun reaction.

E] Connect a Touch Sensor fo port 1 of your NXT and
select the Try-Touch program in the Try Me submenu
on the NXT's display.

2e
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f SOUND SENSOR

The Sound Sensor makes your robot hear!

The Sound Sensor can detect bath decibels [dB] and
adjusted decibels [dBA]. A decibel is a measurement of
sound pressure.

dBA: In detecting adjusted decibels, the sensitivity of | '
the sensor is adapted to the sensitivity af the human | -
ear. In other words, these are sounds that your ears are ))) .
able to hear. I
dB: In detecting standard (unadjusted| decibels, all

sounds are measured with equal sensitivity. Thus, these

sounds may include some that are too high or low for the human ear fo hear.

The Sound Sensor can measure sound pressure levels up fo 90 dB - about the level

of a lawnmawer. Sound pressure levels are extremely complicated, so the Sound
Sensor readings on the MINOSTORMS® NXT are displayed in percent %]. To give some
comparative examples: 4-5% is like a silent living room. 5-10% would be the reading
you get from someone falking some distance away. 10-30 % is normal conversation
tlose to the sensor or music played at a normal level. And you will record readings of
30-100% from people shouting and music played at high valumes.

=

Suggestions for use

You can use the Sound Sensor to make
a sound confrofled robot. Talk to your
robot and it will answer you back. Clap
Test it! vour hands and the robot can pick up

Test the Sound Sensar's ability to read fhinge syt ber 0y Ol
sound valume:
Connect the Sound Sensor ta the NXT.

[T |
- i y ==

qUb
@

(B B

Gelect the View submenu on the Make some sounds into the Sound Sensor and watch the readings

NXT's display. Select the Sound displayed on the NXT. Use the sensor ta read some sounds around you.
Sensor icon and the port where you How loud do your parents speak? How loud is your Front doorbell?

have connected the sensor.

Select the Try Me submenu on the NXT's display and test
your Sound Sensor. You'll get a fun reaction.

:23
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g
<LJ LIGHT SENSOR

The Light Sensor is ane of the two sensars that give
your robof vision [the Ultrasonic Sensor is the ather].
The Light Sensor enables your robot fo distinguish
between light and dark. It can read the light intensity
in a room and measure the light intensity of colored
surfaces.

.. ' This s what your robot will seg,
, . using the light sensar.

' T .. | This is what your eyes see,
Itoe
I|

Suggestions for use

You can use the Light Sensor to make a burglar

alarm robot: when an intruder turns on the light
' in your room, the robot can react to defend your
| property. You can also use the Light Sensar to

' | make a line-fallowing robaot or a robat that can
/ sort things by color.

Detecting ambient [surrounding) light

Test the Light Sensor's ahility to read ambient light by
measuring the light level in different locations of the room.
For example, first hold the sensor against the window. Then
hold it under the table. Watch how the readings differ.

Test it!

You can test the Light Sensor in different ways:
Connect the Light Sensor fo the NXT.

S el
! !
-\ —-r I'L I‘:-’.-_“_-‘:T""ﬁ--.

- ZI' . =

Select the View submenu on the
NXT's display. Select the Light the different readings.
Sensor icon and the part where you
have connected the sensor.

Light Sensor. You'll get a fun reactian.

| 24
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Hold the Light Sensor up ta the different colors on the test pad and cee

Select the Try Me submenu on the NXT's display and test your
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j;}@ ULTRASONIC SENSOR

The Ulfrasonic Sensor is the other sensor that gives

your robot vision. The Ultrasonic Sensar enables the
robot to see and detect objects. You can also use it fo
make your robot avoid ohstacles, sense and measure
distance, and detect movement. A

The Ultrasonic Sensor measures distance in

cenfimeters and in inches on the NXT. It is able to
measure distances from 0 to 255 centimeters with a g
precision of +/-3 cm. \

The Ultrasonic Sensor uses the same scientific principle as bats: it measures
distance by calculating the fime it fakes for a sound wave to hit an object and return
- just like an echo.

Large-sized objects with hard surfaces return the best readings. Objects made of
soft Fabric or that are curved [like a ball] or are very thin or small can be difficult for
the sensor to detect.

Suggestions for use

Note that two or more Ultrasonic Sensors aperating in the same room may interfere  You can use the Ultrasonic Sensor in

with each other's readings. many different ways. Program a robof fo
sneak around the house without it
bumping inta things. Or make an
advanced hurglar alarm robot that reacts

: to movement as well as light, Your

Test it! Scorpion robot “stings” if you come to

Test the Ultrasonic Sensor's ahility to measure distance: close,

Connect the Ultrasonic Sensor to the KXT.

Select the View submenu in the NXT display.

— .

L 3
Bl |
| 4D : :
=
Select the Ultrasonic Sensor icon Measure the distance to an object. For example, move your hand closer fo
ant the port where you've con- the sensor and watch the readings change,

nected the sensar,

Select the Try Me submenu on the NXT's display and test your
Ultrasonic Sensar. You'll get a fun reaction,

25
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INTERACTIVE SERVO MOTORS

The three Servo Motars give your robot the ability
to move. If you use the Move hlack in the

soffware to program your motors, the fwo motors
will automatically synchronize, so that your robot
will move in a straight line,

Built-in Rotation Sensor

Each mator has a built-in Rotation Sensor. This lets
you confrol your robot's movements precisely. The
Rotation Sensor measures motor rotations in degrees
or full rotations [accuracy of +/- one degree].

One rotation is equal to 360 degrees, so if you set a
motar to turn 180 degrees, its output shaft will make
half a turn,

The built-in Rotation Sensor in each
mofor also lets you set different speeds
for your motors |by setting different
power parameters in the saftware), Try
running the mators at different speeds.

Test it!

Test the built-in Rotation Sensor's ability to measure distance:;
Connect a motar to the NXT.

Select the View submenu in the NXT's u‘lﬁplay

1 _-I

i=¥

Select the Motor Rotations ican, Now attach & wheel ta the moter and measure the rotations as you rall the wheel along the Aoor,
Select the port where you have
connected the motar,

select the Try Me submenu on the NXT's display and test your
motars. You'll get a fun reaction.
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==11. The motor
12, Tachometer [Rotation Sensar]
3. Built-in gearing

—

27
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€3 Bluetooth™ usinG sLuerooTH

Bluetooth is a technology that makes it
possible to send and receive data without
using wires ar cables. Using Bluetoath,
you can exchange programs between your
NXT and other NXTs, Or you can establish
a wireless connection between your com-
puter and your robot and fry out programs
instantly — even with your robot on the
other side of the room!

IF you have a mobile phone with Bluetooth
capahility, you can use it to control your
robot. You might even be able to use if as
an advanced sensor, like a camera sensar.
Visit www. MINDSTORMS.com/bluetooth, for

more infarmation on mabile phone require-
ments.
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CONNECTING YOUR NXT TO A COMPUTER

Before you fry to set up a wireless Bluetooth connection, make sure
that your computer has Bluetooth capability.

IF your computer does not have built-in Bluetooth capability, you
must use a Bluetooth USB dongle. Make sure that you use the right
type of Bluetooth USE dongle. Read more about the different types of
Bluetooth USE dongles fo use at www.MINDSTORMS.com/bluetanth

F

Make sure that your NXT is turned on, Also Find the Controller af the lower right corner

make sure that you have Bluetooth set to of the waork area in the software. Click on the
On and that your NXT is set ta be Visible NET window button [the one af the upper left|
|read how in the Bluetooth submenu on and the HXT window will open.

the NXT on page 34). Also make sure that
Bluetooth is installed and enabled on your
computer. 5ee your computer's and
Bluetooth USB dongle's instruction manu-
als for details,

29
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Click Scan. Your computer will automatically search for
Bluefooth devices.

IREEE R T T 1 After a short inferval, a list of available Bluetooth devices
E will appear in the window on the computer screen. Select
I!"irr' L _ b the device you wanf fo connect to and click the Connect
TR - rer— _ button.
_J T Yo drrasst T B
- Hurra Cornaiin Tope | Stim = —_— |
S e, ||
ﬂ Rt NS Il
| I Fres Sorage |
i I- Firrast wr wirpiors
. || e T e o
145
2 = ] |l
) VeI L T g she =gt When you connect to a device For the first time, the Enter
1 yehides | ‘ Passkey window will pop up. Enter the passkey to use with
| - this device |the default passkey is 1234] and click DK,
e ) Enter Posshay %]
i J Tnber & Pasckey 16 ups with this devin, [#] stachines I\]
n s oed For ety sehien connacting o |
o o S 20 ks ey e
— :_m Animas
i
i
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e Enter the passkey on your NXT and confirm the connection
G p——
: - by pushing the orange [Enter] button. If you have chosen

i , the default passkey, just click the orange |Enter] button.
—) | ¥ ||

In the NXT window, the status of your NXT has now changed
from Available to Connected. Your MXT and computer are
now connected and can share dafa,

Ei
i

¢
L

1

Hake sure that your NXT is turned on, Also
make sure that you have Bluetooth set to
On and that your NXT is set to be Visible
|read how in the Bluetooth submenu on
the NXT on page 34). Also make sure that
Bluetooth is installed and enabled on your
compufer. See your computer's and

Bluetooth USB dongle’s instruction manu-
als for defails,

A

Find the Controller af the lower right corner
of the work area in the software. Click on the

NXT window button [the one at the upper left]
and the NXT window will open.

E] |
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L4y = LEGO MINDSTORMS NXT
e T e S| =
'..ﬁ..’"'_@’_... = SRS
Lelect Blustooth Device
T find devices in range of your computer, elick the Srarcs Eutton. Thes
select & Bugtooh Device from tes B ol divions.
| 1 :
Device Tyoe:  All Types EF
Déevice Categary: | All Categonies. T
E Device
: __
=i
[ “Search 1
e = o
i Add to Favarites | [ Cameel )

Llick Sean. The Bluetooth device window will pop up on the
SCrEen.

A list of Bluetooth devices will appear in the Select
Bluetooth Device window on the screen. Select the device
you want fo cannect to and click the Select button,

The NXT that you want fo connect to appears in the NXT
window as availahle. Click the Connect button.
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o e e e

= LEGO MINDSTORMS AKT |
- ——_—— 2 — |

Pair with a Bluetooth Davice

Select 2 Beeieoth Devics and click the Pair Bumpn.

To find devices in rmage of your eomputer 16 paie mith, click the Search
Bummee, ¥ yoor devics |5 nod found rake sung it is "giscoverable” and
stesch g

Shaw only: | &ll Devices 12
Device Category. | All Categaries

Tt i LEGID MINDSTORMS NX T

F— T —

l W Mease enter a Passkey 1o use with shis device
| r" Fassioeys are regered to pait with & Blesioath device. The same
1

aaskey mus be ersered on ihe device 21 well 14 1R COMEUnEr. -"'""h
1 Mokt devices aliow you o create your own Faiskey, but seme i) |
— devices requite a fixed one. |
waT ‘
I 2 J .
(Cancel | ESOKSS) |

Enter the passkey on your NXT and confirm the
connection by pushing the orange [Enter] button. IF
you have chosen the default passkey, just click the
orange [Enter] button.

The Pair with a Bluetooth Device window pops up.
Select the NXT. Click Pair.

When you connect to a device for the first time, a Passkey
window will pop up. Enter the passkey to use with this
device [the default passkey is 1234 and click DK,

Your Macintesh and NXT are now connected and can share datfa.

IH

i
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BLUETOOTH SUBMENU ON NXT

o
bl Lol

4 b
, =

il o —

Bluetooth Search
Search for other Bluetooth devices. Affer you have chosen the Search

Select the Bluetooth submenu an the

HET display, icon, your N&T will automatically start to search for other Bluetooth
devices that it can connect fo.

My Lonfacts

You can see all of your frusted Bluetooth confacts

in My Contacts, These contacts can automatically
connect and send data to your RXT witheut using 2
passkey, To add a new contact to the list, you must
have been connected to the contact before, Devices
which you have been connected to, will automatically
be added to the listin My Lontacts.

Connections

This item displays your current connections, You can
connect your NXT ta three devices af the same fime
[on Ling 1, 2 and 3), while ane device can cannect to
you [on Ling 0], Note, however, that while you can
be “connected” to up fo three devices, you can only
“communicate” with one device at a fime,

—_—e ]

4 A—
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| G

You can also view the connection status in the NAT window in the
software. There you can change the name af yawr NXT, check
battery and memory lavels, and delete programs on your NXT,

Check the connection status in the icon har at the top of

fhe NXT's display.

[F there is no Bluetooth icon shown, Bluetoath is OFF,

:# Bluetaoth is ON but your NXT is nat visible

fo nther Bluefooth devices.

:# < Bluetooth is ON and your MXT is visible fo

other Bluefooth devices,

:#¢. Bluetooth ic ON and your NXT is connected

o a Blustooth device,

Tai»gj

Visibility
Use the Visible opfion to make yaur NXT
visible ar invisible ta ather Bluetanth

devices when they do a Bluetoath search,

Fa—sske'y

The Passkey ensures that only Bluetooth
devices approved by you can connect to
your NET, Whenever you connect foa
Bluetooth device far the first fime using

your NXT, you will be asked far a passkey.
Select the preset passkey 1234 or make up

your own code, Other Bluetooth devices

must know your passkey in order to canfirm

a connection with your NXT.

| t_-i|

| S |
-

Dn/OFF

You can turn Blustooth functionality an
or off. IFyou furn Bluetooth off, you will
not be able ta send or receive data over
Bluetoakh, To save hattery power, tum
off the Bluetanth function when it is not
in use,

Hote! Bluetooth is furned off hy default.
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CONNECTING YOUR NXT TO ANDTHER NXT

| L 2 A

I |
[
p [—= f—

| i
- N

Select the Bluetooth submenu
on the NXT's display.

Select the Search icon to search For
other Bluetooth devices, Your NXT will
automatically search for Bluetooth
devices.

Select the device you want fo connect to,
Remember that you can give each NXT a
unigque name

= 5ee Naming the NXT on page 11

same time.

1 I, ||

| connect.

|3

I_ 49»

el

|
2
i

Uepending on how many devices are
detected in the area, a list will pop up on
the NXT's display after a few seconds,

Select which of the three lines of communication you want the connection to
be on [1, 2 or 3]. You can connect your NXT to three different devices at the

|F you connect to a device for the frst time, your NXT will ask for
| a passkey. Just press enter fo use the default passkey 1234 or
make up your own code, The other Bluetooth device must know
your passkey in order fo confirm the connection. This means
that the two NXTs need to to enter the same passkey in order to

- ' If you want to connect your NXT to mare than one Bluetooth

or start @ new search.

6

‘| devite, go to the My Contacts submenu fo select a frusted confact
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Connecting o more than one NXT

You can connect up to three NXTs or other Bluetooth
devices fo your NXT at the same time. However, you can
only communicate with one device at a time.

Sending fles from NXT to NXT

It's easy to send programs from your NXT to another NXT:

I
T 1)
u:.."

1
i

Make sure that your NXT is connected to
the NXT to which you want to send the
program |see page 36, Connecting your
NXT to another NXT).

Gelect the My Files submenu in the NXT's
display and select the program you wanf
to send.
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Select Gend.

Select which of the connected devices you
want the program fo be sent to [Line 1,2
or3].

Your MXT will now send the file.

Connecting your NXT to a mohile phone
IFyou have a mohile phane with Bluetooth capability,
you can use it with your LEGO® MINDSTORMS® NXT set.
Go to www. MINOSTORMS.com/bluetaoth For more infor-
mation on mobile phone requirements. Here you can also
download the MINOSTORMS NXT Bluetooth connection
program for your mobile phone and get additional infor-
mation on how fo connect your NXT to mabile phones.
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SYSTEM REQUIREMENTS -“‘Hf'

Before installing the LEGO® MINDSTORMS® NXT Software,
you must make sure that your computer meets the
following minimum system requirements;

Windows . Macintosh

« |ntel® Penfium® processor or compatible, » PowerPC® 63, b4, G5 processar, 600 MHz minimum
800 MHz minimum » Apple Mac05Xv. 10.3.9or 10.4

= Windows %P Professional ar Home Edifion » 256MB of RAM minimum
with Service Pack 2 » Lp fo 300MB of available hard disk space

= 256M8B of RAM minimum « XGA display [1024x768|

« Up to 300MB of available hard disk space « 1 available USB port

- XGA display [1024x768) « CD-ROM drive

= 1 available USB port » Compatible Bluetooth adapter [optional|*

» Compatible Bluetoath adapter [optional|*

= [O-ROM drive ( /'

-4

*Supparted Bluetooth software include Widcomm® Bluetooth Far Windows [newer thanwv, 1.4.2.10 SP5|, and the Bluetooth stacks included
in Microsaft Windows %P [with Service Pack 2] and Apple Mac05 X [10.3.9 and 10.4]. For more detfails on compatible Bluetoafh adapters,
see www. MINOSTORMS. com/bluefoath.

INSTALLING THE SOFTWARE

Microsoft Windows

Exit all open programs.

Insert the CO-ROM.

IF the CO-ROM does nof run automatically:

- click the Start button [at the bottom left-hand
corner of your screen)

= click Run

- type d:\autorun.exe (where d: is your CD drive|

38
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2 Select your preferred language.
‘ Follow the on-screen instructions.

LEGO® MIMDSTORMSE MNXT
Software v1.0

| Nederlands |

| Englsh Al
Frangais |

|

|

|

[
| B
[ Ex

EmndsTorms

Apple Macintosh
Exit all open programs.
Insert the CO-ROM,

Open the "LEGO MINDSTORMS NXT™ CO-ROM and double-click Install.
Select your preferred language.
Follow the an-screen instructions.

When the installation procedure is complete, click Finish. You are now ready fo use the
LEGD MINDSTORMS NXT Software and create programs for cool robatic inventions,

19
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This simple program will make the NXT play a
YUUR FIRST PRDGRAM EDII.Isnsl:lml;llr:lfH'I" hel:':!n::ndersfand hni.'i'n

connect your computer to the NXT.

Start the software on your PC or Macintosh
by double-clicking the program icon.

Type in the name of your first program,
or just click on bo!

:_‘__,.. ! >
] "
| Start New Program
IE
|E |y First Program | o
| Bade Y
] | = LE{ Open Recent Program ‘
—J | =] | &> ; (
. . | =
1:3j . o S ] First, click on the Sound black icon in
N ‘ the programming palefte.
) r 3 I
. D oo |
_4]”] r",-' e 3
[_.._.iﬁnun:l |

40
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Orag a Sound block and drop it to the right of the
Starting point in the work area.
Your program is now ready to download and run.

Make sure you turn on your NXT and connect the LISB
cable to both your computer and the NXT [see page 8,
Connecting the NXT technology).

Laocate the Controller in the lower right corner of the
work area. Click Download and run [the central but-
ton| and listen to what happens.

Congratulations, you have completed your Arst
program!

~.|_D|:|wnfuad andrunf| | |
J] )
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SOFTWARE USER INTERFACE

A quick averview

1. Robo Center

2. My Portal

3. Tool bar

4, Work area

5. Little help window

6. Waork area map

7. Programming palettfe
8. Configuration panel
3. Controller

10. NXT window
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Robo Center window
Here you can find building and programming instructions for four cool models.

My Paortal
Here you tan access www.MINOSTORMS.com while programming your robats,
You can get more robotic challenges and download programs, sound effects and other cool stuff.

The tool bar
The tool bar includes the most frequently used commands from the menu bar in an easy-to-reach
Incation,

The work area
This is the space on the screen where programming takes place. Orag programming blocks from the
programming palette to the work area and attach the blocks to the sequence beam,

Little help window
Here you can always get help if needed.

| The work area map

" Use the pan tool on the tool bar to move around the work area - and use the wark area map [fab in the

lower right corner] to get an overview.

The programming palette

The programming palette contains all of the programming blocks you will need to create your
programs. The tabs at the bottom of the palette |ef you switch between the comman palette [containing
the most frequently used blocks|, the complete palette [containing all of the blocks|, and the custom
palette [confaining blocks that you download or create yourselF).

The configuration panel
Each programming block has a configuration panel that lets you customize the block for the specific
input and output that you want,

The Contraller

" The five buttons on the Controller let you download programs [or parts of programs) from your

computer fo the NXT. With the Lontroller you can also change the settings of your NXT.

The NXT window
This pop-up window will give you information about your NXT's memory and communications settings.

43
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THE ROBO CENTER

Robo Center

vehicles

* Quicktart

Animals

m'—ﬂ'h'h:
Robo Lenter

[E] wehicles

* Quickitar

L TriBot * sart herer (0

e,

== e — L e—

_3_) Buikfing Giside

turm befit, right or stop.

Programming Guide g

Can you buid the robat 50 that it drives in the sxact dractions you want?
YouTneed to buld a tough driving bass that ean ga Torwards, badowards,

In the Robo Center you will find different robof models
that you can build and program to do what you want,

Start by selecting a robot model to build and program.
We recommend that you start with the Trifot as itis a
continuation of the Ouick Start model included in the box.

Follow the on-screen building and programming
instructions — or solve the challenge on your awn.

A
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= — -== ] Test your robot using the challenges provided,
[ Busding Gulds ol

Programming Guide

(Tl i program your robok bo go Forwards on the kest pad and then | |
rystes back ba the starting poick st & Faster spesd? |

ECiE
1
==

i

THE PROGRAMMING PALETTE

The programming palette contains all of the programming
‘ hilocks you will need to create your programs. Each
programming block determines how your robot acts or
| reacts, By combining blocks in sequence, you can create
programs that will make your robot come to life.

: When you have Anished creating your program,
r_|_ : [ _ download it to the HXT and run it,

Remember to turn on and connect your NXT before
downlpading a program.
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.,

5

«—-_;;|

CIEIE]

Lommon palette

We recommend that you to start with the blacks in the
common palefte. You should be able to finish all of the
starter challenges in the Robo Center with just these blocks.

The software's help area has more information about the rest

of the programming blocks when you are ready to move an.

Move block

This block confraols the robot's motors and
synchronizes its movements. Use this block to
set your robof fo go forwards or backwards in
a straight line or to turn by following a curve.

Record/Play block

This block lets you record a physical
movement with your robot and then play back
the recorded movement elsewhere in the
program.

Sound block

Use this hlock fo play a sound fle or a single
fone, To compose a melody of tones, arrange
several sound blocks in a row.

e
Display black
T Use this block to display an image, write some
' fext, or draw a shape on the NXT's display
screen.
il

46

To simplify its use, the programming palette has been
divided into three palette groupings: the comman
palette [containing the most used blocks|, the
complete palette [containing all of the programming
blocks|, and the custom palette [containing blocks yau
download or create yourself].

Wait block

This block lets your robot sense its environment
for a specific condition before it continues with the
program. For example, use the Wait block to make
the robot wait for a specific sound, touch or fime,
hefore it moves on with the program,

Loop block

Use this block if you want your robot to do the
same thing again and again. For example, make
your robot move forwards and backwards
continuously until the Touch Sensor is pressed.

Switch block

This block lefs your robot make its own decisions,
such as going leff when it hears a loud noise and
going right when it hears a soffer noise.
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THE CONFIGURATION PANEL

Each programming block has a configuration panel that lets you adjust the
settings of the block for the specific actions that you want, When a block
is selected in the work area, its configuration panel will be visible at the
bottom of the screen.

By changing the parameters on each configuration panel, you can change
how a particular block will behave. For example, to make your robot move
faster, you can change the Power property on the Mave block's configuration
panel.

_E Pon: Oa @8 c S rover (@ [7]
‘7 Direcion:  C=h O 4= O =% Duration: | 1| [Rotations  []
%) sweingt (¢ [5) T (B8 ()] i Newaction: @ | Brake O by Coan

¢ 9 Y

THE CONTROLLER

The Ave buttans on the Confroller communicate from your computer to the NXT:

The NXT window button gives you access
to the NXT's memory and communications
'|d setfings.

=

= -
The Download button downloads the program
to the NXT. You can then run the program
from the NXT. =
The Download and run buttan
downloads a program fo the
NXT and then starts running the
program.

The Download and run selected button

downloads and runs just a piece of your

program'’s code [e.q. a single block or just

a few blocks). Select the blocks you want

to test and click on the Download and run

selected button, You will then be able o see
=) how the small sequence of your program

performs on the NXT without having to

download the whole pragram.

=) The Stop button staps a running program,

a7 |



B LEGO® BRICKS

ELEMENT OVERVIEW

These are the LEGO® bricks in the MINOSTORMS® NXT set #8527,

48 |
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B LEGO® BRICKS

TEST PAD

Test all your models on this test pad.

EmndsTorms

I

TEST PAD @3 B527

~———_1  This is the starting point on the pad.
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B LEGO® BRICKS

LABELS

Use these labels to decorate your robots.

-

JINDS ¥H1In|
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You can use these labels to stick around
bath ends of a cable, to make sure the
cable is connected to the right part.

|

| =
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TROUBLESHOOTING

Resetting the NXT

If the running icon stops spinning, your NXT has frozen
and you will need to reset it, Follow these steps to reset your NXT:

Make sure that your NXT is furned on.

I Push the resef button that is located on the back of
your NXT in the LEGD® Technic haole in the upper left

! corner, Use, for example, an unfolded paperclip to
press the button.

il > IFyou press the reset button for maore than 4 seconds
= I you will need to update the firmware [see below].

Updating the Armware in the NXT from your computer
Go fo Tools = Update NXT Firmware.

T e T e e e T | Make sure that your NXT is turned on.
) LEGO MINDSTORMS NXT | ‘ Note! IF you have just reset your NXT [see above|

Fie Edit ‘Todls Help s, the display will nof show anything. A ficking sound

=1 . Calbrate Sensors will tell whether it is furned on or not.
L te NAT Fil Make sure that your NXT and computer are connected

Shmmen with the USB cable.
: ;\'“&} ' Go to the Tools pull-down menu in the soffware's
| ‘Eﬁf menu bar and select Update NXT Firmware.
|
DI
|‘—'-'-" = r “

iy | [Ms
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=1 Update NXT Firnware @EB ‘
Lt deseninaded Frmarera: LGS MINGSTERNS FOT Fimman vid  [thstars
P ontoa i C o ]|

a Awalable P Filen

hines \

lals

<
?
[

I Dragpraie seected bl [remars
Lacating POCT Brapiring HIT Drwedond |
|

3 ] | e—

Select the irmware you want to update.

Click download. [Note! The Windows ‘Found new
hardware wizard will pop up the first fime you
update your Rrmware. Complete the wizard by
following the on-screen instruction before you
continue|.

For other types of troubleshooting, go fo www.MINOSTORMS.com/suppart

FCC approval:
Model: MINDSTORMS NXT  FCC ID:NPIS3788

This device complies with part 15 of the FLC Rules. Operation is subject fo the following 2 conditions:

1. This device may not cause harmful inferference.

2. This device must aceept any interference received including interference that may cause undesired operafion,

Warning:

Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's authority to

operate the equipment.

NOTE:

This equipment has been tested and found to comply with the limits for a Class 8 digital device, pursuant to part 15 of the FLL Rules.

These limits are designed fo provide reasonable protection against harmful interference in a residential installation,
This equipment generates, uses an can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmFul interference to radio communications, However, there is no guarantee that interference will not occur in a particular
installation. I this equipment does cause harmful interference to radio or television reception, which can be determined by turning the

equipment off an on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna,
- Increase the separation hetween the equipment and receiver.

- Connect the equipment into an outlet on a circuit different From that to which the receiver is connected,

Consult the dealer or an experienced radio/TV fechnician for help.

Hereby LEGO Company declares that MINDSTORMS NXT [B527) is in compliance with the essential requirements and other relevant

provisions of Directive 1999/5/E.
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Quick Build
Schnellbaumadelle
Construction rapide
Costruzione rapida
Snel bouwen
Construccion rapida
Byg hurtigt

MNopeaan rakentamiseen
Byag snabbt
Construcado Rapida
Mpfyopes Kataokeuéc
Kisérleteziknak

Experienced Build
Konnermodelle
Construction normale
Costruzione esperta
Bouwen voor gevorderden
Caonstruccion experta

Byg videre

Kokeneelle rakentajalle
Bygg mer

Construcio para Experimentados
EmdiEien Kataokeues
Haladcknak

Advanced Build
Profimodelle
Construction avanceée
Costruzione avanzata
Geavanceerd bouwen
Construccion avanzada
Byg avanceret
Taitavalle rakentajalle
Bygg avancerat
Construcao Avancada
EEEAIy UEVED KOTOOKEVERD
Frofiknak
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